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1   Introduction

This user guide describes the use of the NXP GUI for Automotive PMIC Family in development using the
FS2600 Automotive PMIC family, referred to hereafter as FS26. This document is intended for engineers
involved in evaluation, design, implementation, and validation using the FS26 Fail-safe system basis chip with
multiple SMPS and LDO.

The scope of this document is to provide the user with information to evaluate the FS26 Fail-safe system basis
chip with multiple SMPS and LDO. This document covers connecting the hardware, installing the software and
tools, configuring the environment, and using the evaluation boards.

The NXP GUI for Automotive PMIC Families enables development on the FS26 family of devices. This GUI
allows the user to play with registers, try OTP configurations, and burn the part.

Figure 1. NXP GUI for FS26 Automotive PMIC family
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2   Finding resources and information on the NXP website

NXP Semiconductors provides online resources for this GUI and its supported devices on http://www.nxp.com.

The information page for NXP GUI for Automotive PMIC Families is at http://www.nxp.com/NXP GUI for
Automotive PMIC Families. The information page provides overview information, documentation, downloads,
and development tools.

2.1  Collaborate in the NXP community
The NXP community is for sharing ideas and tips, asking and answering technical questions, and receiving
input on just about any embedded design topic.

The NXP community is at http://community.nxp.com.
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3   FS2600: safety system basis chip with low power for ASIL D / ASIL B

3.1  General description
Devices in the FS26 automotive safety System Basis Chip (SBC) family are designed to support entry and mid-
range safety microcontrollers, like those in the S32K3 series. FS26 devices have multiple power supplies and
the flexibility to work with other microcontrollers targeting automotive electrification. Possible FS26 applications
include power train, chassis, safety, and low-end gateway technology.

This family of devices consists of several versions that are pin to pin and software compatible. These versions
support a wide range of applications with automotive safety integrity levels (ASIL) B or D, offering choices in
number of output rails, output voltage settings, operating frequencies, power up sequencing, and integrated
system level features.

The FS26 features multiple switch mode regulators and low dropout (LDO) voltage regulators to supply the
microcontroller, sensors, peripheral ICs, and communication interfaces. It offers a high-precision reference
voltage supply for the system, and for two independent tracking regulators. The FS26 also offers various
functionalities for system control and diagnostics, including an analog multiplexer, general-purpose inputs/
outputs (GPIOs), and selectable wake-up events from I/O, long duration timer (LDT), or serial-peripheral
interface (SPI) communication.

The FS26 is developed in compliance with the ISO2 6262 standard, and includes enhanced safety features
with multiple fail-safe outputs. It uses the latest on-demand latent fault monitoring, and can be part of a safety-
oriented system partitioning scheme covering both ASIL B and ASIL D safety integrity levels.

3.2  Features and benefits

3.2.1  Operating range

• 40 V DC maximum input voltage
• Supports operating voltage range down to battery 3.2 V with VBST
• Supports operating voltage range down to battery 6 V without VBST
• Low Power OFF mode with 30 µA quiescent current
• Low Power Standby mode with 29 µA quiescent current with VPRE active

– LDO1 or LDO2 activation selectable via OTP configuration
– GPIO1 or GPIO2 activation selectable via SPI communication
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3.2.2  Power supplies

• VPRE: synchronous buck converter with integrated FETs
– Configurable output voltage and switching frequency
– Output DC current capability up to 1.5 A
– PFM mode for Low Power Standby mode operation

• VCORE: synchronous buck converter with integrated FETs
– VCORE is dedicated for microcontroller core supply
– Output DC current up to 0.8 A or 1.65 A (depending on part number)
– Output voltage range setting from 0.8 V to 3.35 V

• VBST: asynchronous boost controller with external low-side switch, diode, and current sense resistor
– VBST is configurable as front-end supply to withstand low-voltage cranking profiles or in back-end supply

with configurable output voltage and scalable output DC current capability
• LDO1: LDO regulator for microcontroller I/O support with selectable output voltage between 3.3 V and 5.0 V

and up to 400 mA current capability
• LDO2: LDO regulator for system peripheral support with selectable output voltage between 3.3 V and 5.0 V

and up to 400 mA current capability
• VREF: High-precision reference voltage with 0.75 % accuracy for external ADC reference and internal

tracking reference
• TRK1and TRK2: Voltage tracking regulators with selectable output voltage between VREF, LDO2, or internal

LDO reference. Supports high-voltage protection for ECU off board operation. Each tracker has a current
capability up to 150 mA
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3.2.3  System support

• Two wake-up inputs with high-voltage support for system robustness
• Two programmable GPIOs with wake-up capability or HS/LS driver
• Programmable LDT for system shutdown and wake-up control
• Monitoring of system voltages (including battery voltage monitoring) through the analog multiplexer
• Selectable wake-up sources from: WAKE/GPIO pins, LDT or SPI activity
• Device control via 32-bit SPI interface with cyclic redundancy checks (CRC)

3.2.4  Compliancy

• Electromagnetic compatibility (EMC) optimization techniques for switching regulators, including spread
spectrum, slew rate control, and manual frequency tuning

• Electromagnetic interference (EMI) robustness supporting various automotive EMI test standards

3.2.5  Functional safety

• Scalable portfolio from ASIL B to D
• Independent monitoring circuitry, dedicated interface for microcontroller monitoring, simple, or challenger

Watchdog function
• Analog built-in self-test (ABIST) and logical built-in self-test (LBIST) at startup
• Analog built-in self-test (ABIST) on demand
• Safety outputs with latent fault detection mechanism (RSTB, FS0B, FS1B)

3.2.6  Configuration and enablement

• LQFP48 pins with exposed pad for optimized thermal management
• Permanent device customization via one time programmable (OTP) fuse memory
• OTP emulation mode for hardware development and evaluation
• Debug mode for software development, MCU programming, and debugging
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4   Getting ready

Working with the FS26 requires the kit contents, additional hardware, and a Windows PC workstation with
installed software.

4.1  Development board and accessories
The development boards (with accessories) are available on the NXP website. Three different boards are
available:

• Programming socket board: KITFS26SKTEVM
– Available on https://www.nxp.com/KITFS26SKTEVM

• Automotive evaluation board: KITFS26AEEVM
– Available on https://www.nxp.com/KITFS26AEEVM

4.2  Additional hardware
In addition to the development board, the following hardware is necessary or beneficial when working with this
kit.

• Power supply with a range of 8.0 V to 40 V and a current limit set initially to 1.0 A.

4.3  Windows PC workstation
The software requires a Windows PC workstation. Meeting these minimum specifications produces great results
when working with this evaluation board.

• USB-enabled computer with Windows 7 or Windows 10

4.4  Software
The software must be installed before working with the NXP GUI and the evaluation boards. All listed software
is available on the NXP GUI information page at http://www.nxp.com/NXP GUI for Automotive PMIC Families or
from our 'Secure Files' portal at https://www.nxp.com/mynxp/secure-files.

4.5  Configuring the hardware for startup
The development board setup must be completed before using the NXP GUI. This setup is described in the
“Configuring the hardware for startup” section in the dedicated user manual available for each board kit:

• Programming socket board: KITFS26SKTEVM
– Available on https://www.nxp.com/KITFS26SKTEVM

• Automotive evaluation board: KITFS26AEEVM
– Available on https://www.nxp.com/KITFS26AEEVM
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5   Installing and configuring software and tools

The programming/evaluation boards are always delivered with the GUI firmware already flashed. If the MCU
firmware is already flashed, this section can be ignored. If it is specified that the firmware must be updated, or if
it is malfunctioning, follow these instructions.

5.1  Flashing or updating the GUI firmware

5.1.1  Flashing the Freedom board firmware on Windows 7/10

If BOOTLOADER is already loaded in the FRDM Board, steps 1 and 2 are not required. Start from step 3.

1. Disable the Storage Service and Windows Search: Run Services, double-click, and stop them as shown in
Figure 2.

Figure 2. Services configuration

 
2. Press the RST button and connect the USB cable to the SDA port on the Freedom Board.

• A new BOOTLOADER device appears on the left pane of the File Explorer.
3. Drag and drop the file “MSD-DEBUG-FRDM-KL25Z_Pemicro_v118.SDA” to the BOOTLOADER drive.

Ensure there is enough time for the firmware to be saved in the BOOTLOADER.
4. Disconnect the USB cable, then reconnect it to the SDA

port.
• This time WITHOUT pressing the RST button, the

FRDM_KL25Z device appears on the left pane of the
File Explorer as pictured in Figure 3.

Figure 3. FRDM-KL25Z in left pane

 
5. Locate the file “nxp-gui-fw-frdmkl25z-usb_hid-device_version.bin” from the package. Drag and drop this file

into the FRDM_KL25Z device.
Ensure that there is enough time for the firmware to be saved.

6. The Freedom board firmware is successfully loaded. Disconnect the USB-cable and reconnect it to the
KL25Z USB port.
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5.2  Installing the NXP GUI software package
To install the FS2600 NXP GUI, download or obtain the NXP GUI package, unzip an open 1-NXP_GUI_Setup
folder:

Figure 4. NXP_GUI_Setup folder

Then double-click on the NXP_GUI_version-Setup.exe and follow the instructions.

Figure 5. NXP_GUI_version_Setup.exe

To install the application on a Windows PC, proceed with the following pop-up windows:

Figure 6. NXP GUI setup
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Figure 7. NXP GUI setup configuration

Select the following options before completing the installation of the setup:

• Run NXP_GUI
• Show Readme

Figure 8. NXP GUI setup completion

Select Finish to complete the installation.

When the installation is finished, find the application by searching for NXPGUI in the Windows search bar. Click
to launch.
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6   Configuring the hardware

Figure 9. Device programming

To configure the hardware and workstation, complete the following procedure:

1. With SW1 in the middle position, set the DC power supply to 12 V and the current limit to 1.0 A. Attach
the DC power supply positive and negative outputs to KITFS26AEEVM VBAT Phoenix connector (J20), or
connect the 12 V power supply to VBAT Jack (J2).

Schematic label Signal name Description

J20-1 VBAT Battery voltage supply input

J20-2 GND Ground

Table 1. VBAT Phoenix connector (J20)

Schematic label Signal name Description

SW1pin 2-3 VBAT Phoenix Board supplied by Phoenix connector

SW1pin 2 (middle position) VBAT Board not supplied

SW1pin 2-1 VBAT jack Board supplied by jack connector

Table 2. VBAT three position connector (SW1)

2. Connect the Windows PC USB port to the KL25Z USB side of the Freedom board included in the kit, using
the provided USB 2.0 cable.
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3. Turn on SW6 to apply VDBG to the DEBUG pin or SW7 to apply VOTP.
4. Turn on the power supply.
5. Close SW1.

Note: At this step, the product is either in Debug mode, and all regulators are turned OFF, or in OTP emulation
mode. In the latter, the user can then power up with a preloaded OTP configuration or manually configure the
mirror registers before powering up (the power up is effective as soon as SW7 is turned off).
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7   Using the FS2600 NXP GUI

To follow the steps in this section, ensure the board is connected using the appropriate hardware configuration
(see the board user information in UM11503 and UM11504).

Always use the latest version of the NXP GUI.

7.1  Establishing the connection between the NXP GUI and the hardware
The device manager allows the connection of the FS26 development board with the NXP GUI.

Before plugging the KL25Z USB port USB to the computer, the MCU is in a “NOT DETECTED” state.

Figure 10. MCU state is NOT DETECTED

After plugging in the USB, the MCU state changes to “DISCONNECTED”. If the state does not change, press
the RST button on the Freedom board.

Figure 11. MCU state is DISCONNECTED

In this state, the communication with the MCU can be started.

Figure 12. MCU state is CONNECTED

The MCU state changes to “CONNECTED” and the firmware version is displayed.

To start the communication with the FS2600, click the Start button.

Figure 13. Click Start button

When the communication has started successfully, the FS2600 switches to Green.

Figure 14. FS26 is now green

When the device starts with the DEBUG pin voltage at VOTP (on the EVBs: SW7 ON, DBG jumper populated,
OTP mode led ON), the state machine stops at the M/FS_STATES: 4-Debug entry state.
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The current mode can be read at the bottom of the GUI window and is automatically refreshed when
transitioning to another state. Also, it is possible to manually refresh when clicking the current status button.

Figure 15. Current mode

The user can click Apply test mode to send Main and Fail-safe test mode entry keys. If test mode is entered
correctly, button changes to Exit test mode.

Figure 16. Button changes to Exit test mode

When test mode is entered, options requiring test mode are enabled, such as Mirrors and device programming.

Click Polling to do a continuous check of test mode entry.

If the device versioning bits are already programmed with an existing part number, the NXP GUI decodes and
displays the assigned Device ID. The following example displays FS2633D.

Figure 17. Device ID display
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7.2  Starting the FS2600 NXP GUI
When the kit is ready and the NXP GUI is installed, click to launch the kit from the Windows search bar.

Figure 18. KIT selection window
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To avoid the kit selection window on every launch, check the “Use this configuration and do not ask again” box. The
window shown in Figure 19 opens.

Figure 19. NXP GUI framework

The FS2600 GUI interface is now in use. It can be divided in several parts:

• Settings: Import or export files; configure framework
• Device Manager: Start communication with device; enter or exit test mode; SPI communication settings
• Tool Access Bar: Quick access to the FS2600 evaluation tools and features
• Window Log: Microcontroller and device communication events
• Tab Content: Content of each tool or tab – there can be more tabs, boxes, or windows
• Micro and Device Status: Displays whether USB or device is connected or disconnected; displays Firmware

and GUI version; displays the current state of the FS state machine – click Display button to refresh

Note:  The tool access bar shows the GUI tools in the sequence they must be used. The first step is to
verify device POWER dissipation and then configure the OTP. When the power is verified and OTP is done,
the device can be programmed or emulated with a SCRIPT. MIRROR registers can be read/modified to a
configuration validation. To verify states and configure safety reactions, the Access tab allows manipulation of
the registers.
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7.2.1  Framework settings

The NXP GUI main menu has five GUI elements: File, View, Export, NXP, and Help.

Figure 20. Framework settings

7.2.1.1  File

Load or save a configuration or exit the application. Load and save are only enabled when OTP tool tab is
active.

Figure 21. File options

• Load: Loads an existing configuration file previously exported from OTP tool, to continue to modify it on the
OTP tool. This file has a .cfg extension. It is identified as: FS26_ProgIDASILlevel_CONFIG.cfg.
Example: FS26_A0D_CONFIG.cfg.

• Save: Saves the current configuration of the OTP tool as a .cfg file.
• Use default configuration: Loads default values into the OTP tool.
• Exit: Exits NXP GUI application.

7.2.1.2  View

This main menu has options related to the GUI display.

• Display
• Show
• Naming Conventions

Display: It consists of the Connection Tool Bar (enabled by default) option. To show or hide, go to View →
Display and then select Connection Tool Bar.

Figure 22. Display options
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Show: This option can be used to access various sections of the GUI.

Figure 23. Show options

Naming Conventions: Select Friendly or Register name display for the OTP tool. This option is enabled only
when the OTP tool is active.

Figure 24. Naming conventions options

Friendly: Go to View → Naming Conventions → Friendly. This mode helps to view the the registers names as
user-friendly names throughout the OTP tool.

Figure 25. Friendly mode

Register: Go to View → Naming Conventions → Register. This mode helps to view the register names as the
registers' technical names throughout the OTP Tool.

Example: VSUP UV threshold → VSUP_UVTH_OTP
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7.2.1.3  Export

This option allows the user to export the current OTP from the OTP tool into different script formats.

• OTP: Exports OTP configuration into OTP script file for programming
• TBB: Exports OTP configuration into a TBB script file for emulation
• I-HEX: Exports to Intel Hex script file
• S-HEX: Exports to Simple Hex script file.

Figure 26. KIT selection window

This option is enabled only in the OTP Tool, and remains disabled in other sections of the GUI.

7.3  OTP tab
The OTP tool allows the configuration of OTP registers and generates scripts for OTP emulation or OTP
programming. These scripts program parameters that the main state machine and the fail-safe state machine
control.

The OTP tool includes four tabs:

• System Configuration
• Switching and LDO Regulators
• Voltage Monitoring
• System Safety Configuration
• OTP ID

These five tabs are used to define the entire FS26 OTP configuration.

When the OTP configuration is defined, TBB/OTP scripts can be generated using the Export menu. Generate a
TBB file for emulation and an OTP file for OTP programming.

It is possible to save a configuration to use or to modify it later. To export the OTP configuration, click Save
Config. To import a configuration initially saved from the OTP tool or the Mirrors tab, click the Import button.

7.3.1  System Configuration tab

The system configuration tab has several sections:

• Block Diagram: This graphic shows the output voltage set for each supply rail (VBST, VPRE, VCORE ...).
• System Configuration: Clock frequency, VSUP undervoltage threshold, auto retry ...
• Power-up Sequence: This box is used to define the power sequence of the device – if the configuration is

modified, the Sequence Diagram is updated automatically.
• I/O Configuration: This last box is used to configure the four I/Os available on the FS2600 (GPIO1, GPIO2,

WAKE1, and WAKE2).
• Sequence Diagram: This diagram reflects the power-up sequence of the FS2600 depending on the OTP

configuration – the power-up sequence timing may not be 100 % accurate.
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Figure 27 shows an OTP configuration example.

Figure 27. OTP System Configuration Tab, part 1 of 2: Block Diagram, System, and Power-up Sequence
configurations

Figure 28 shows a voltage monitoring recap connection and the resulting power-up sequence diagram.

Figure 28. OTP System Configuration tab, part 2 of 2: I/Os Configuration and Power-up sequence diagram
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7.3.2  Switching Regulators tab

The Switching Regulators tab shown in Figure 29 has three sections:

• VPRE Configuration: Minimum ON and OFF time in PFM mode and the slope compensation are set and
cannot be modified. Also, VPRE transition voltage when going to Standby mode (VPRE_BOS_OTP) is linked
to VPRE output voltage in Standby mode (VPRE_LP_OTP).Other parameters can be chosen.

• VBST Configuration: VBST minimum ontime is already set. Other parameters can be chosen.
• VCORE Configuration: VCORE conduction mode is already set. Other parameters can be chosen.

Figure 29. OTP SMPS regulators Configuration tab

7.3.3  LDO Regulators tab

The LDO Regulators tab shown in Figure 30 has five sections:

• LDO1/LDO2 Configuration: Linear dropout regulators configuration
• VREF Configuration: High-precision voltage linear dropout regulator configuration
• TRK1/TRK2 Configuration: Voltage tracking regulators configuration

Figure 30. OTP LDO Regulators Configuration tab

7.3.4  Voltage Monitoring tab

The Voltage Monitoring tab shown in Figure 31 has eight sections:
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• VMONPRE/VMONCORE/VMONTRK1/VMONTRK2/VMONEXT Configuration: Defines OV/UV thresholds
and deglitch timings for VPRE, VCORE, TRK1 and TRK2 regulators. The monitoring voltages are bound to
the respective regulator voltage set in the Switching/LDO Regulators tab (except for VMONEXT).

• VMONLDO1/VMONLDO2/VMONREF Configuration: Defines OV/UV thresholds, normal or degraded UV
(except for VREF), pin lift detection enablement and deglitch timings for LDO1, LDO2 and VREF regulators.

Figure 31. OTP Voltage Monitoring Configuration tab

7.3.5  System Safety Configuration tab

The System Safety Configuration tab shown in Figure 32 has two sections:

• ABIST1 Configuration: Allows the user to enable or disable ABIST1 execution for each available kind of
monitoring

• System Safety Configuration: DFS, FS1B behavior, Watchdog, LBIST, RSTB, ...

Figure 32. OTP System Safety Configuration tab

7.3.6  OTP ID tab

The OTP ID tab shown in Figure 33 has three sections:

• Program ID: Shows the OTP ID code
• FS Versioning Bits: DFS, FS1B behavior, Watchdog, LBIST, RSTB…
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• Versioning Bits: Allows the user to choose one of the generic part numbers from the dropdown list – this
automatically updates the related OTP and VOTP configuration bits to match the selected part number
(VCORE current capability, LDT, TRK2, FS1B, ABIST2, Watchdog, Fault recovery, FCCU, and LBIST)

Figure 33. OTP ID tab

7.4  Device programming
The Device Programming tab shown in Figure 34 allows the user to burn the FS2600 OTP using a script initially
generated by the OTP tool. In order to enable this window, the device must be in test mode.

Figure 34. Device programming

To program an OTP configuration, the VOTP voltage must be applied to the DEBUG pin. To do so, the user must
turn on SW7 to apply 8.0 V to the FS26 DEBUG pin.

Click Browse to select an OTP script file, then click the Program button to run the script. If the DEBUG pin
voltage is not set to VOTP, a pop up appears to ask the user to turn on SW7, or it turns on automatically if jumper
J13 is on Automatic mode J13 3-2.

If the required conditions are met (sectors are available), the programming process starts. Otherwise, the
execution is canceled. To verify that the sectors are available, click Read from the Fuse Box Status window.

OTP is programmed into SECTBE2 of Main and Fail-safe. SECTBE1 and SECTBE0 are reserved for NXP
users only.

Blue or ‘0’: Available
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Yellow or ‘1’: Not available

When programming is complete, a pop up appears to ask the user to turn off SW7 and SW6 (set DEBUG pin
voltage to 0 V).

If the device was programmed correctly, the power-up sequence starts. Fuse box status can be read to check
whether sectors are burned. In some conditions, a power up could be required.

7.5  Script tab
The registers and OTP emulation can be configured with the Script editor shown in Figure 35. The Script editor
is useful for trying various OTP configurations in OTP Emulation mode.

Figure 35. Script editor

The main subareas of this panel are:

• Command Script Editor: Builds commands to be sent to the device.
• Script Text Editor: Sends a sequence of register configurations from a text file or from a command edited

directly in this area.
• Script Results: Displays result status of each command sent to the device.
• Sent and Received Commands: Displays a summary of commands sent and received from the device.
• Management Commands: These commands are used for scripts.

7.5.1  Command script editor

Using the script editor, the user can execute any command either directly or from a file. It is also possible to
save and modify a script. Using the brush symbol, it is possible to clean windows if necessary.

All commands must follow a specific syntax. The Help menu describes the commands available in the script
editor and the syntax to be used.
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Figure 36 shows an example of building a command from the panel.

Figure 36. Script Editor: Help window
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7.5.2  Management commands

Some commands are used for formatting the scripts. Figure 37 shows the description of each button.

Figure 37. Script editor commands

• Run: Runs the script once.
• Loop: Runs the script continuously in a loop.
• Save: Save the script that is present in the script command window in text file.
• Open: Open a saved script from the desired location.
• Clear: Clears the script command window.
• Script Editor Help Window: Describes the commands available in the script editor and their formats.

7.5.3  Script editor

The script editor allows the user to create or send existing sequences to the device. The user can read/write
individually to a register, to an I/O, or to an analog pin. The user can emulate an OTP configuration as well with
this tab.

This tab can be accessed from Toolbar → SCRIPT or View → Show → Script Editor.

Figure 38. Script Editor
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The script can be written by selecting and configuring the pins and registers that are available in the script
commands section or by loading a previously exported .txt file.

Figure 39. Use script editor to access more commands

Click one type of command to access more options, until the command to build the sequence is found.

• Digital pins: Select the pin name, then pin value (HIGH or LOW). The command is automatically added to the
script.

Figure 40. Digital Pins

• Analog pins: Select the pin name and then write the pin value. If the pin is read only, the pin value is not
enabled and it gets added to script editor automatically.

Figure 41. Digital Pins

• Registers: Select the Operation (Read/Write).
– Read: Select the register group, then the register name. The register is added to script editor automatically.
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Figure 42. Registers: Read
• Write: Select the register group, then the register name. Write the value and click the enter key. The value must be

written in HEX. Press the Enter key to add to the editor.

Figure 43. Registers: Write

• Mode: Write command to exit or enter different device modes.
– Test mode: Send main and Fail-safe test mode entry keys.
– User mode: Exit test mode if device is in test mode.

• Generator: Select an existing script to add to the script editor. Some options may require to be in a specific
mode or state.

Figure 44. Generator
The script operations can be found at the bottom of the script editor window. This section is responsible for:

• Execution of script
• Script management: Create, Open, Save, Run
• Logging feature: Load, Save, Clear
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Figure 45. Script editor controls

Run: Runs the script once

Loop: Runs the script continuously in a loop

Save: Saves the script that is present in the script command window in a text file

Open: Opens a saved script from the desired location

ATE: Saves the script in ATE format

Clear: Clears the script command window

Script Editor Help Window: This section describes the commands available in Script editor, and their formats.
This option can be accessed from Menu → SCRIPT → Help or View → Show → Script Editor → Help.

7.6  Mirrors tab
Test mode must be applied to enable the Mirrors tab. This tab is divided into main and fail-safe mirrors registers,
shown in Figure 46 and Figure 47, respectively.

The Read/Write All buttons can be used to read/write the entire set of mirrors registers. The Mirrors
configuration can be exported and imported in the OTP tool as an OTP configuration to generate TBB/OTP
scripts files.

Figure 46. Main mirrors tab
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Figure 47. Fail-safe mirrors tab

7.6.1  Read/write operation

To read a bit group, click Read from a box. Read values are displayed to the right of each register.

Figure 48. Read bit group

To write to a bit group, modify the controls of each register, then click Write.
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Figure 49. Write bit group

7.6.2  Read/write all and write all operation

Read All reads the bits of each block from all mirror registers.

Read values also appear at the right of each register in the window log.

Figure 50. Read all

To write all OTP bit groups configuration, click Write All.
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7.6.3  Mirror registers export option

This operation generates a configuration file, which is saved as a text file in the local device. The configuration
file can be imported into this tab later. Figure 51 shows the generated .txt configuration file.

Figure 51. Export option for reference
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7.6.4  OTP import to mirror registers

This option is used to import the configuration file previously saved. Click OTP Import and select the .txt
configuration file previously saved from this tab.

Figure 52. OTP Import for reference
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7.7  INT tab
To access the Interrupt Editor window, click Menu → INT or View → Show → Interrupt Editor.

The Interrupt Editor window has two tabs: the Interrupt Configuration tab and the Safety Diagnostic tab.

7.7.1  Interrupt Configuration tab

The Interrupt Configuration tab shown in Figure 53 allows the monitoring of the regulators, the wake inputs,
the I/Os, and the communication events or status. It also allows the reading, writing and polling of overvoltage/
undervoltage, overtemperature, and overcurrent.

Figure 53. Interrupt Configuration tab

These commands can be used to manage the interrupts:

• Clear all: All interrupts in the box are cleared. The user can also click the individual check boxes from the
Clear column.

• Read: Gives the status of all interrupts in the box.
• Poll: Reads interrupts' values in a loop.

A few tips are given below to help the user:
• Blue means Low or not activated.
• Yellow means High or activated.
• To mask a specific interrupt, the user can check the interrupt's box from the Mask column.
• Click Read on each box to read the current status or Read All  to update the whole tab.
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7.7.2  Safety Diagnostics tab

The Safety Diagnostics tab allows the monitoring of safety events such as VMON status, bad WD, SPI
communication errors, FCCU pins, safety outputs, ABIST1 and ABIST2 status.

Figure 54. Safety Diagnostics tab

ABIST1_PASS yellow means the ABIST1 is done and its status is PASS, since the user can read ‘1’ from its
register. '0' or blue after execution means fail.

Sense status can only be read (RSTB_DRV, RSTB_SNS, FS0B_DRV, ...).
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7.8  Access tab

7.8.1  Register map

All FS2600 SPI registers can be accessed in write and read mode using this tab shown in Figure 55. These
registers are divided into three sections:

• Functional: Main functional SPI registers (diagnostics, configuration, and controls)
• Safety: Safety SPI registers (diagnostics and configuration)
• Write INIT safety: Safety registers that can be configured during INIT FS state (for example, WD

configuration and WD window)

Figure 55. Register map access

To read the values of a register, click the READ button. The value is read from the device and is displayed on a
label near the READ button. It is also displayed in the log window.

To write the bit values individually, click the desired bit. The corresponding bit button color changes. The value is
updated in the log window. Click the WRITE button to write to the register. To write the values through a text box
near the WRITE button, enter the appropriate write value. Then click the WRITE button to write to the register.

When registers have been selected, global commands can also be used:

• WRITE: Writes data to all the selected register at once.
• READ: Reads data back from the selected register at once.
• RESET: Resets all the input text boxes to 0x00. Write bits are set to '0'. Change register bit buttons are set to

the default setting.

The value can also be written by selecting the Edit option near the WRITE button. Bits and corresponding
values are displayed in a pop window as shown in Figure 56. Select the options of all write bits, close the input
dialog box, and click the WRITE button. Selected input combinations are written to the register.
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Figure 56. Bit map dialog

Writing an INIT safety register automatically updates the corresponding NOT register.

7.8.2  INIT safety tab

This tab allows the configuration of a safety output reaction in case of fault for voltage monitoring, FCCU,
ERRMON Watchdog monitoring, as shown in Figure 57. See the FS2600 data sheet for a complete description
of these registers.

It is required to be in INIT_FS state to configure these registers.

Click the combo box controls to select the desired configuration, then click Write.

Figure 57. INIT safety tab

Read All and Write All buttons are implemented to facilitate configuration.

UM11812 All information provided in this document is subject to legal disclaimers. © 2023 NXP B.V. All rights reserved.

User manual Rev. 2 — 22 March 2023
37 / 58



NXP Semiconductors UM11812
NXP GUI for FS26 Automotive PMIC Family

7.8.3  FS Config tab

This tab helps to configure safety features, such as Watchdog and Fault Error counter. Click Read All to get the
current configuration.

Figure 58. FS Config tab

7.8.4  Regulators tab

The regulator tab shown in Figure 59 is used to configure the FS2600 SMPS, LDO, or GPIOs. SPI can enable
or disable each regulator. Check the enable (EN) or disable (DIS) box, then click the Write button. These
registers do not provide regulator status. The VPRE regulator can be only enabled or disabled in test mode.

Figure 59. Regulators tab
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7.8.5  AMUX tab

The AMUX tab shown in Figure 60 allows the selection of an AMUX pin channel. The pin channel gets its
current value by using the KL25Z AMUX ADC pin. The user can do a single read, or display various channels
dynamically on the voltage or temperature graph.

The displayed values already apply the divider and temperature formulas. Voltage regulators are also monitored
independently on the KL25Z ADC pins.

To use the dynamic graph, select the channel then click the + button to add to the graph. To start polling, click
the Poll button. Click the Poll button again to stop measurements.

Figure 60. AMUX measurements
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7.9  I/O pins tab
This section can control some I/Os connected to the KL25Z plugged-in Freedom. It can read the device safety
outputs externally, or control different voltage sources in order to apply sequences to apply Debug mode without
moving any switches.

The input pins are the pins that can be read from the MCU. They are input pins from the MCU point of view.
This section contains the safety outputs FS0B, FS1B, and RSTB. It can be read once with the Read button, or
the user can select at which frequency the user wants to the read the pins. Select the duration, then start polling
with the Poll button.

Figure 61. I/O pins tab

The output pins are thresholds that can be controlled with the MCU. These pins are described in the FS26
Hardware User Manuals UM11503 and UM11504.

• MCU_DBG8V: 8 V on DEBUG pin
• MCU_DBG5V: 5 V on DEBUG pin
• VBAT_Ctrl: open or close VBAT power supply

They can be used instead of the manual switches SW6 and SW7. In order to use MCU_DBG5V and
MCU_DBG8V for DEBUG pin control, J13 must be set for Auto mode (J13 position 3-2). Select High or Low to
control the pins. The default is Low.
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In order to use VBAT_Ctrl, the jumper JP1 next to the VBAT switch must be off. Once JP1 is removed, use
VBAT_Ctrl instead of SW1 to turn the power supply on or off.
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Figure 62. VBAT_Ctrl and JP1 schematic view

These pins are also accessible from the script editor and can be used to create script sequences.
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8   Using an FS26 evaluation board

Before starting the process, consult the development board scheme and the hardware user manual to configure
the required use case.

Learn about OTP before operating with the device. The device has a high level of flexibility due to the parameter
configurations available in the OTP. It impacts the functionality of the device. It is key to understand how OTP
parameters can be programmed, the interaction with mirror registers, and the FS2600 SoC.

The OTP-related operations can only be performed in OTP mode (Emulation or programming). When using
emulation, the device loses the configuration when the power supply is switched off, when the device enters
deep fail-safe, or when it enters standby mode.

Once the NXP GUI is installed (Section 5), follow these instructions for a quick power up (Section 8.1), debug
(Section 8.2), programming, or to enter the various operating modes (Section 8.3, Section 8.7, Section 8.8) of
the FS26 SBC.

8.1  Power up
If the FS26 device contains an OTP configuration, connect a power supply to the VBAT Phoenix connector or
the VBAT jack connector. See Section "VBAT connectors" from the hardware user manual.

NXP recommends setting the power supply to an initial value of 12 V and limiting the current to 1.0 A.

Make sure the board has the correct jumper configuration. Every kit is delivered with a default configuration
shown in Figure 63. This configuration is suitable for a boost in front-end topology.

Figure 63. Jumpers default configuration
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Verify that the KL25Z is plugged in, as well as the USB cable on the KL25Z USB connector side. Connecting
the USB cable is important, for these reasons: It enables communication with the NXP GUI, provides voltages
and references to some circuits on the board, and generates the VDDIO reference for the IC (J12 is set to
VDDIO_USB by default).

Figure 64. USB cable connection

After validating or considering all the previous statements, use switch SW1 to power on the board.

If the OTP configuration has many safety features enabled, the device may restart or power off after a few
seconds. To prevent this, enter Debug mode to waive some of those features.

8.2  Debug mode entry
The Debug mode is intended for MCU programming (MCU flash mode) and software debugging. During the
power-up sequence, the Fail-safe state machine starts in Debug mode and goes directly to the INIT_FS state.
To enter Debug mode without first entering OTP Emulation mode, follow the next steps once the kit is ready:

1. Make sure the device is powered off (SW1 in middle position).
2. Turn on SW6 to apply VDBG (~5.0 V) to the DEBUG pin. Make sure the jumper J13 has the right

configuration. The default is Manual.

Figure 65. Jumpers and switches configuration for Debug mode entry
3. Power on VBAT (SW1) and the device enters Debug mode. In this mode, the Watchdog is disabled, the

RSTB 8 s counter is disabled, and FS0B is low and cannot be released.
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4. To check that the device is in Debug mode, use the NXP GUI register map window (ACCESS tab) to read the DBG_
MODE bit in the FS_STATES register (latched information) or VDBG_VOLT_S in M_STATUS (real-time information).

Figure 66. DBG_MODE bit in FS_STATES register

Figure 67. VDBG_VOLT_S bit in M_STATUS register

8.3  Test mode entry
To enter test mode, the device must be in Debug mode. Test mode can be accessed by writing the appropriate
key sequences.

Access Test mode from the NXP GUI device manager, or write the keys in the script editor.

From device manager:

Click Apply test mode to send the Main and Fail-safe test mode entry keys.

Figure 68. Apply test mode

From script editor:

Copy and paste the keys in the script editor:

// Main Test mode entry

SET_REG:FS26:M_TestMode:M_TM_ENTRY:0x0000

SET_REG:FS26:M_TestMode:M_TM_ENTRY:0xD5A7

SET_REG:FS26:M_TestMode:M_TM_ENTRY:0xB8EE

SET_REG:FS26:M_TestMode:M_TM_ENTRY:0x0F37

//Fail Safe Test mode entry

SET_REG:FS26:FS_TestMode:FS_TM_ENTRY:0x0000

SET_REG:FS26:FS_TestMode:FS_TM_ENTRY:0xD5A7

SET_REG:FS26:FS_TestMode:FS_TM_ENTRY:0xB8EE

SET_REG:FS26:FS_TestMode:FS_TM_ENTRY:0x0F37

GET_REG:FS26:FS_TestMode:FS_TM_STATUS1
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Click Run script.

8.4  Emulate an OTP configuration
OTP mode is intended for OTP emulation and OTP programming. When an OTP configuration is emulated, the
configuration remains available until the POR of the digital circuitry. The Fail-safe configuration is lost in Low
Power mode (LPOFF mode or Standby mode) since the Fail-safe digital is off in these modes. The Main digital
configuration is lost when VSUP is removed, which means VBOS < VBOS_POR.

During the power-up sequence, the Main and the Fail-safe state machines stops prior to starting the regulators,
waiting for SPI communication to send an OTP configuration to the device. When the OTP configuration is
complete, the Fail-safe state machine starts in Debug mode when the voltage at the DEBUG pin is below
VNORM_max (NXP recommends applying 0 V or GND).

Before starting, make sure that the power conditions from Section 8.1 are valid.

If not in OTP Emulation mode:

1. Ensure the device is powered off (SW1 in middle position).
2. Turn on SW7 to apply ~8 V to the DEBUG pin. Make sure the jumper J13 has the right configuration. The

default is Manual.

Figure 69. Jumpers and switches configuration for OTP emulation mode entry
3. Power on VBAT (SW1) and the device enters OTP Emulation mode. The status of the LEDs should be as

shown in Figure 70.
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Figure 70. OTP emulation mode LEDs status

If already in OTP Emulation mode:

1. Open the NXP GUI.
2. Connect the device.
3. Open the script editor.

4. Open the provided or created OTP configuration script (TBB) to load into the mirror registers.

A TBB script usually contains the test mode entry keys. If they are not present in the script, see Section 8.3 to
enter test mode.

After running the script, read the mirror registers to verify the loaded OTP configuration in the OTP Mirrors
tab. Turn the SW7 off to apply 0 V on the DEBUG pin in order to start the power-up sequence and move to the
INIT_FS state.
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8.5  Programming the device with an OTP configuration
Instructions in this section are intended to burn an OTP configuration permanently into the fuses. The device
sectors can be programmed only one time. Make sure that sectors are available.

The user can program an OTP configuration from the Device Programming tab or from the Script editor. See
Section 7.4.

1. If not in OTP Emulation mode, see Section 8.4.
2. Apply test mode.
3. Go to the Device programming tab (PROG) on the left panel.
4. Click Read to get the device current fuse box status.
5. Click Browse and select the desired OTP configuration script.
6. Click Program to initiate the device programming.
7. A window appears to ask the user to turn off SW6 and SW7. Proceed to apply 0 V at the DEBUG pin.
8. OTP programming is now complete. The device has started and is now in the INIT_FS state.

Enabled regulators should have their respective LEDs turned on. See Figure 71.

Figure 71. Status of LEDs once OTP programming is complete

Note: Regulators LEDs status depends on the OTP configuration used.
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8.6  Go to INIT_FS
Use these instructions before powering up the device, to get to the INIT_FS state from Debug mode or from
OTP Emulation mode.

In Debug mode:

1. Device is powered off (SW1 in the middle position).
2. Switch on the SW6 to access Debug mode.
3. Power on the device (using SW1).
4. If no programmed or emulated OTP configuration is preloaded, only VPRE will turn on. See Section 8.4 or

Section 8.5 for more details.
5. Power-up sequence is complete and the device is now in INIT_FS state. The user can verify this from the

Micro and Device Status bar.

In OTP Emulation mode:

1. Device is powered off (SW1 in the middle position).
2. Switch on the SW7 to access OTP Emulation mode.
3. Power on the device (using SW1).
4. The device state machines stop to Debug entry state (see the Micro and Device Status bar).
5. If no programmed or emulated OTP configuration is preloaded, only VPRE will turn on. See Section 8.4 or

Section 8.5 for more details.
6. Turn off SW7 (0 V on DEBUG pin) to allow the state machines to resume. The device follows its power-up

sequence according to the programmed or emulated OTP configuration.
7. Power-up sequence is complete and device is now in INIT_FS state. The user can verify this from the Micro

and Device Status bar.

Figure 72. INIT-FS state

8.7  Go to Normal mode
To enter Normal mode from the GUI, the user must be in Debug mode and in INIT_FS state. When using the
simple Watchdog (WD), the user can send a script to release the device safety output pins FS0B and FS1B. If
the Watchdog is set to challenger, the sequence must be sent manually.

Using the Script editor

1. Once in INIT_FS state, the user must verify ABIST1 is PASS from the Safety diagnostics tab.
2. Configure or check the Watchdog type from the Mirrors tab.
3. Use one of the following scripts to release the safety output pins. Use script A for simple Watchdog or script

B for challenger Watchdog. The script to release the safety output pins is available in the device manager
Script tab: from Script editor tab → Generator → Safety outputs release → Run.
a. Sequence to enter Normal mode with a simple Watchdog:

//INIT FS and simple WD enabled required
//Open WD window
SET_REG:FS26:Safety:FS_WDW_DURATION:0x008B
SET_REG:FS26:Safety:FS_NOT_WDW_DURATION:0xF144
//Send 1st good wd refresh to close INIT window
SET_REG:FS26:Safety:FS_WD_ANSWER:0x5AB2
//clean fault error counter
SET_REG:FS26:Safety:FS_WD_ANSWER:0x5AB2
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SET_REG:FS26:Safety:FS_WD_ANSWER:0x5AB2
SET_REG:FS26:Safety:FS_WD_ANSWER:0x5AB2
SET_REG:FS26:Safety:FS_WD_ANSWER:0x5AB2
SET_REG:FS26:Safety:FS_WD_ANSWER:0x5AB2
SET_REG:FS26:Safety:FS_WD_ANSWER:0x5AB2
//Exit dbg mode
SET_REG:FS26:Safety:FS_STATES:0x4000
//release FS0B and FS1B
SET_REG:FS26:Safety:FS_RELEASE_FS0B_FS1B:0xB2A5

b. Sequence to enter Normal mode with a challenger Watchdog:
//INIT FS and WD Challenger required
//Open WD window
SET_REG:FS26:Safety:FS_WDW_DURATION:0x008B
SET_REG:FS26:Safety:FS_NOT_WDW_DURATION:0xF144
//Send 1st WD refresh to close INIT window
SET_REG:FS26:Safety:FS_WD_ANSWER:0xa54d
//clean fault error counter
SET_REG:FS26:Safety:FS_WD_ANSWER:0x4a9a
SET_REG:FS26:Safety:FS_WD_ANSWER:0x9535
SET_REG:FS26:Safety:FS_WD_ANSWER:0x2a6a
SET_REG:FS26:Safety:FS_WD_ANSWER:0x54d4
SET_REG:FS26:Safety:FS_WD_ANSWER:0xa9a9
SET_REG:FS26:Safety:FS_WD_ANSWER:0x5353
//Exit dbg mode
SET_REG:FS26:Safety:FS_STATES:0x4000
//release FS0B and FS1B
SET_REG:FS26:Safety:FS_RELEASE_FS0B_FS1B:0xA565

Sending commands manually

To release the safety output pins manually and step by step, proceed with the following instructions:

1. Configure the WD window. Since it is not possible to send a WD refresh periodically, the user must disable
the WD window. From the FS Config tab (ACCESS tab on the left panel), go to the WD Window box, select
'Disable (INFINITE OPEN WINDOW)', and click Write.

Figure 73. Disable WD window
Or execute it from the Script editor: Generator → OpenWD-Window → Run.

2. From the same tab (FS Config), in the Clear Errors box, click WD Challenger or WD Simple (depending
on the WD type) one time to send a first good WD refresh and move on the Fail-safe state machine.
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Figure 74. Send a WD refresh
Or execute it from the Script editor: Generator → Simple-WD/Challenger-WD → Run.

3. Send the right number of good WD refreshes in order to clean the Fault Error counter. Example: Default
number is '6'. Click six times on the WD Challenger or the WD Simple button. Verify that the Fault Error
counter is now '0' (FLT_ERR_CNT) in the FS Config tab.

4. Exit Debug mode. Go to the Register Map tab, then in the Safety registers, set the EXIT_DBG_MODE to '1'
to exit Debug mode.

Figure 75. Set EXIT_DBG_MODE to '1'
5. In the Release FS Outputs box from the FS Config tab, send a 'Release FS0B' or a 'Release FS0B-FS1B'

command to move to Normal mode.

Figure 76. Release FS outputs
6. Once these steps are completed, the device should be in Normal mode. To verify the current state, read the

FS_STATES status in the Micro and Device Status bar, or click it to update.

Figure 77. Read FS_STATES
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8.8  Go to Low Power mode
From the INIT_FS or the Normal mode state, the device can go into one of the two Low Power modes: LPOFF
mode (all regulators are disabled) or Standby mode (VPRE and selected LDOs remain enabled).

Prior to going into Low Power mode, the user must select a way to wake up the device afterward. Use the
ACCESS tab to find the M_WIO_CFG register in the Register map, then set the appropriate bits to '1' to enable
the respective wake-up source(s) (IO1/2, WAKE1/2...).

Figure 78. M_WIO_CFG register

The user can now either run the preset script 'Go to Standby', from the Generator in the Script editor, to go into
Standby mode, or run the preset script 'Go to LPOFF' to go into LPOFF mode.

Figure 79. Go to STANDBY or LPOFF
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10   Legal information

10.1  Definitions
Draft — A draft status on a document indicates that the content is still
under internal review and subject to formal approval, which may result
in modifications or additions. NXP Semiconductors does not give any
representations or warranties as to the accuracy or completeness of
information included in a draft version of a document and shall have no
liability for the consequences of use of such information.

10.2  Disclaimers
Limited warranty and liability — Information in this document is believed
to be accurate and reliable. However, NXP Semiconductors does not give
any representations or warranties, expressed or implied, as to the accuracy
or completeness of such information and shall have no liability for the
consequences of use of such information. NXP Semiconductors takes no
responsibility for the content in this document if provided by an information
source outside of NXP Semiconductors.
In no event shall NXP Semiconductors be liable for any indirect, incidental,
punitive, special or consequential damages (including - without limitation -
lost profits, lost savings, business interruption, costs related to the removal
or replacement of any products or rework charges) whether or not such
damages are based on tort (including negligence), warranty, breach of
contract or any other legal theory.
Notwithstanding any damages that customer might incur for any reason
whatsoever, NXP Semiconductors’ aggregate and cumulative liability
towards customer for the products described herein shall be limited in
accordance with the Terms and conditions of commercial sale of NXP
Semiconductors.

Right to make changes — NXP Semiconductors reserves the right to
make changes to information published in this document, including without
limitation specifications and product descriptions, at any time and without
notice. This document supersedes and replaces all information supplied prior
to the publication hereof.

Applications — Applications that are described herein for any of these
products are for illustrative purposes only. NXP Semiconductors makes no
representation or warranty that such applications will be suitable for the
specified use without further testing or modification.
Customers are responsible for the design and operation of their
applications and products using NXP Semiconductors products, and NXP
Semiconductors accepts no liability for any assistance with applications or
customer product design. It is customer’s sole responsibility to determine
whether the NXP Semiconductors product is suitable and fit for the
customer’s applications and products planned, as well as for the planned
application and use of customer’s third party customer(s). Customers should
provide appropriate design and operating safeguards to minimize the risks
associated with their applications and products.
NXP Semiconductors does not accept any liability related to any default,
damage, costs or problem which is based on any weakness or default
in the customer’s applications or products, or the application or use by
customer’s third party customer(s). Customer is responsible for doing all
necessary testing for the customer’s applications and products using NXP
Semiconductors products in order to avoid a default of the applications
and the products or of the application or use by customer’s third party
customer(s). NXP does not accept any liability in this respect.

Terms and conditions of commercial sale — NXP Semiconductors
products are sold subject to the general terms and conditions of commercial
sale, as published at http://www.nxp.com/profile/terms, unless otherwise
agreed in a valid written individual agreement. In case an individual
agreement is concluded only the terms and conditions of the respective
agreement shall apply. NXP Semiconductors hereby expressly objects to
applying the customer’s general terms and conditions with regard to the
purchase of NXP Semiconductors products by customer.

Export control — This document as well as the item(s) described herein
may be subject to export control regulations. Export might require a prior
authorization from competent authorities.

Evaluation products — This product is provided on an “as is” and “with all
faults” basis for evaluation purposes only. NXP Semiconductors, its affiliates
and their suppliers expressly disclaim all warranties, whether express,
implied or statutory, including but not limited to the implied warranties of non-
infringement, merchantability and fitness for a particular purpose. The entire
risk as to the quality, or arising out of the use or performance, of this product
remains with customer.
In no event shall NXP Semiconductors, its affiliates or their suppliers
be liable to customer for any special, indirect, consequential, punitive
or incidental damages (including without limitation damages for loss of
business, business interruption, loss of use, loss of data or information, and
the like) arising out the use of or inability to use the product, whether or not
based on tort (including negligence), strict liability, breach of contract, breach
of warranty or any other theory, even if advised of the possibility of such
damages.
Notwithstanding any damages that customer might incur for any reason
whatsoever (including without limitation, all damages referenced above and
all direct or general damages), the entire liability of NXP Semiconductors,
its affiliates and their suppliers and customer’s exclusive remedy for all of
the foregoing shall be limited to actual damages incurred by customer based
on reasonable reliance up to the greater of the amount actually paid by
customer for the product or five dollars (US$5.00). The foregoing limitations,
exclusions and disclaimers shall apply to the maximum extent permitted by
applicable law, even if any remedy fails of its essential purpose.

Translations — A non-English (translated) version of a document, including
the legal information in that document, is for reference only. The English
version shall prevail in case of any discrepancy between the translated and
English versions.

Security — Customer understands that all NXP products may be subject to
unidentified vulnerabilities or may support established security standards or
specifications with known limitations. Customer is responsible for the design
and operation of its applications and products throughout their lifecycles
to reduce the effect of these vulnerabilities on customer’s applications
and products. Customer’s responsibility also extends to other open and/or
proprietary technologies supported by NXP products for use in customer’s
applications. NXP accepts no liability for any vulnerability. Customer should
regularly check security updates from NXP and follow up appropriately.
Customer shall select products with security features that best meet rules,
regulations, and standards of the intended application and make the
ultimate design decisions regarding its products and is solely responsible
for compliance with all legal, regulatory, and security related requirements
concerning its products, regardless of any information or support that may be
provided by NXP.
NXP has a Product Security Incident Response Team (PSIRT) (reachable
at PSIRT@nxp.com) that manages the investigation, reporting, and solution
release to security vulnerabilities of NXP products.

Suitability for use in automotive applications (functional safety) —
This NXP product has been qualified for use in automotive applications.
It has been developed in accordance with ISO 26262, and has been
ASIL classified accordingly. If this product is used by customer in the
development of, or for incorporation into, products or services (a) used in
safety critical applications or (b) in which failure could lead to death, personal
injury, or severe physical or environmental damage (such products and
services hereinafter referred to as “Critical Applications”), then customer
makes the ultimate design decisions regarding its products and is solely
responsible for compliance with all legal, regulatory, safety, and security
related requirements concerning its products, regardless of any information
or support that may be provided by NXP. As such, customer assumes all
risk related to use of any products in Critical Applications and NXP and
its suppliers shall not be liable for any such use by customer. Accordingly,
customer will indemnify and hold NXP harmless from any claims, liabilities,
damages and associated costs and expenses (including attorneys’ fees)
that NXP may incur related to customer’s incorporation of any product in a
Critical Application.
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10.3  Trademarks
Notice: All referenced brands, product names, service names, and
trademarks are the property of their respective owners.

NXP — wordmark and logo are trademarks of NXP B.V.
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